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About Alere AutoLink
AlereDataLink.com, the result reporting and data management website of Alere
Toxicology, has an automated component that users can install and activate to regularly
retrieve their test data. Through a full-time connection to the Internet, this program,
called Alere AutoLink, enables the same print and export functions available through
our website without requiring entry of search criteria or commands. Once installed on
your computer, the program automatically prints or downloads test results at
predetermined intervals throughout the day. AutoLink is easily configurable and allows
for many printing and downloading options. It doesn’t interfere with other software
running on your computer. By default, AutoLink launches automatically when your
computer starts up and downloads and/or prints any test results that have become
available since the last AutoLink session.

Alere AutoPrint
Users of Alere AutoPrint can print drug test results in one of two formats – list or report.
The list format provides a record of the drug tests that have been completed and
includes limited information on each result in a grid. The report format provides a
detailed and easily comprehensible report on each test result. A full-page report
includes all the pertinent information regarding the donor, client, collector, and test
panel and the signature of the Certifying Scientist, making it a certified copy of the
result. Once you have selected a format and interval for printing, Alere AutoPrint
searches Alere’s website for completed testing and prints the results in the format
selected via the user’s default printer. When Alere AutoPrint has printed a record, it
remembers that action, and at the next printing interval, it will not include that report,
eliminating duplicates.

Alere AutoExport
Those clients that require our results to be imported into a database or software system
can utilize Alere AutoExport to set regular intervals to export results from Alere. This
information comes in a comma-delimited ASCII file or XML file that is stored on your
computer or designated network location until you are ready to import them. After you
set an interval for exporting, AlereAutoExport searches Alere’s website for completed
testing, compiles results into a single file, and saves them to your computer or
designated network location. As with printing, the marking of previously exported
records through AutoExport eliminates duplicate results.

Requirements
n
n
n
n
n
n
n
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Windows 2000, XP, or higher
High-speed Internet Connection
Internet Explorer 5.01 or higher
50Mb of free disk space
Pentium 166 or Higher
®
®
Adobe Reader (http://get.adobe.com/reader/)
®
Microsoft .NET 1.1 Framework
(http://www.microsoft.com/downloads/details.aspx?FamilyId=262D25E3-F5894842-8157-034D1E7CF3A3&displaylang=en)
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Setup
To utilize Alere AutoLink, you must have access to Alere’s website,
www.aleredatalink.com. Alere assigns users a Remote ID, User ID, and Password
to access results online, and this information will also be used within the AutoLink
program. Alere will first forward you an email with your login information for Alere
DataLink. We will then activate your account for AutoLink and send you an email with
two links to use for installation. The following guides you in the installation and
program processes.

Help Desk
If you have any questions about the program, please contact Alere’s Client Services
Department at 800.433.3823. You may also request assistance by emailing
toxcs@alere.com or completing the Customer Support form on Alere AutoLink.
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Installing Microsoft .NET 1.1 Framework
You must have the Microsoft .NET 1.1 Framework on your computer before installing
the AutoLink application.
1) You can download this directly from Microsoft at
http://www.microsoft.com/downloads/details.aspx?FamilyId=262D25E3-F589-48428157-034D1E7CF3A3&displaylang=en.

2

2) Click the Download button. A dialog box
asks you to Run or Save the program.
3) Click the Run button. A dialog box
indicates the progress of the program.
4) Once complete, the Internet Explorer –
Security Warning dialog box asks you to
run the program.

5

5) Click the Run button. The Microsoft .NET Framework 1.1 Setup dialog box asks if
you would like to install the program.

6
6) Click the Yes button. The Windows Installer box opens with the progress of the
installation. Once it disappears, the Microsoft .NET 1.1 Framework is installed.
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Installing AutoLink
1) Once you have installed the Microsoft .NET 1.1 Framework, you may click on the
other link in your email to download and install Alere AutoLink. The link is as
follows: https://www.aleredatalink.com/downloads/Autolink20/autolink.msi. A dialog
box asks you to confirm you want to open/install this program.

2
2) Click the OK button. The File Download
– Security Warning dialog box asks you
to Run or Save the program.

3

3) Click the Run button. A dialog box
indicates the progress of the program.
4) Once complete, the Internet Explorer –
Security Warning dialog box asks you to
run the program.

5

5) Click the Run button. The Alere
AutoLink installation wizard starts.

6

6) Click the Next button. The Installer proceeds to the next screen.
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7) You may leave the Folder field as the default, or you may change it by clicking the
Browse button.
8) You may also elect who can use the AutoLink program.
a) If you check the Everyone option, any user that logs into that
computer will be able to use the program. This is the recommended
option.
b) If you check the Just me option, you will be the only user that can
utilize AutoLink on this computer.
9) Click the Next button. The installer proceeds to the confirmation screen.

10

10) Click the Next button. The
installation progress screen
appears.
11) At the conclusion of the
installation process, the
Installation Complete screen
appears.

6 | Installing AutoLink

AutoLink User Guide

12

12) Click the Close button.
13) Alere AutoLink is available under your Programs menu.
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Setting Up AutoLink Options
1) On the Start Menu of your computer, navigate to All Programs > Alere AutoLink >
Alere AutoLink to initiate the program. The AutoLink startup screen appears.

2) The Main tab of the Options screen appears.

a
b
c
d
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3) You may change the defaults listed for each of the following.
a) Print Interval – This field defines how often AutoLink prints or exports results.
The default interval is every 30 minutes, meaning AutoLink searches for results
to print every half-hour. You may increase or decrease this by simply typing
another number. Please note that the interval is in minutes. If you want to
print or export every 3 hours, you need to enter “180.”
b) Timeout – This field defines when AutoLink times out, which is the amount of
minutes AutoLink waits for the results to be received from the server. The
default timeout interval is 5 minutes. If results are not received from Alere’s
server in this time, the program stops and restarts. You should not change this
setting unless directed by Alere IT.
c) Minimize on Setup – If you want the program to minimize on the startup of
your computer, place a check in this box. If not, the program opens up and
stays on the screen whenever you start AutoLink.
d) Check For Program Updates and Automatically Install Updates – You may
elect the way you want the Alere AutoLink program to update itself when new
versions are available.
n
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You are unable to check the Automatically Install Updates option without
activating the Check For Program Updates option.
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n

Checking both boxes directs the program to automatically look for available
updates and then install them without prompting you.

n

If you only select the Check for Program Updates option, the program
notifies you when updates are available. You need to install them
manually when prompted.

4) Once complete, click the Apply button.
5) Before you can activate any other options, you need to link at least one remote ID
to the program. Click on the Remotes tab.

5
6

7

6) Click on the arrow next to the first line to select it. Click inside each field to enter
the RemoteID, UserID, and Password that Alere emailed to you upon setup.
a) If you are using the Print Option, make the square a check mark by clicking in
the box for Print.
b) If you are using the Export Option, make the square a check mark by clicking in
the box for Export.
7) Once complete, click the Apply button. Your completed Remotes tab should be
similar to the following:

8

9
8) If necessary, you may add multiple logins by clicking the asterisk on the next
available line and entering another RemoteID, UserID, and Password. Then,
activate the Print or Export options accordingly.
9) If you don’t have any other options to update on any of the other tabs, you may
click the OK button to complete the setup process.
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Print Options – AutoPrint
1) To use the AutoPrint function, click on the Print Options tab to get the following
screen to appear. In accordance with the Print Interval set under the Main
Options tab, the system compiles reports, saves them to your computer, and then
automatically prints them if you have checked the Automatically Print Document
option described below.

1
a

b
c
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e
f
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2) You may change the defaults listed for each of the following.
a) Report Format – The program defaults to List Format. If you want full page
reports for each result record, use the pulldown menu to select Report Format.
b) Automatically Print Document – The program defaults to automatically print
the documents it generates. If you just want to save and not print the report
files, you may uncheck this box.
c) Acrobat Timeout – Alere recommends a 20 second time out for Adobe
Acrobat, but you may increase or decrease this if you choose or if instructed by
Alere or your IT department.
d) Positive Results Only – The program defaults to retrieve all results. If you
want only the positive results, which includes determinations of Invalid,
Substituted, and Adulterated, check the box next to “Positive Results Only.”
e) Acrobat Path – The program automatically picks up the path to your Acrobat
Reader as the location to save files. Unless instructed by Alere or your IT
department, you may leave this field as is. Keep in mind that if you upgrade
your Acrobat program, you will need to update this field manually.
f)

Delete Report files if older than ## days – Alere AutoLink’s print function
indefinitely saves the .pdf document associated with the retrieved reports. If
you only want to keep your report files for a certain period of time, check the
box and alter the timeframe. The program deletes files older than the number
of days you have indicated.

3) Once complete, click the Apply button.
4) If you don’t have any other options to update on any of the other tabs, you may
click the OK button to complete the setup process.
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Export Options – AutoExport
1) To use the AutoExport function, click on the Export Options tab to get the following
screen to appear.
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2) You may change the defaults listed for each of the following.
a) File Extension – The program defaults to a file extension in accordance with
the Export Format you chose.
i)

If you choose Comma Delimited, this file extension is “.asc.” You should
not change this unless directed to by Alere IT, your IT, or you know the file
extension you need to use.

ii)

If you choose XML as your Export Format, you are unable change the File
Extension.

b) Pos. Results Only – The program defaults to retrieve all results. If you want
only the positive results, which includes determinations of Invalid, Substituted,
and Adulterated, check the box.
c) Export Path – You must designate the location on your computer or network
where you want the exported file to be saved. You can do this by clicking on
the ellipsis button (…) and navigating to your preferred location.
d) Export Format – The program defaults to Comma Delimited. If you want an
XML format, use the pulldown menu to select XML. If you choose XML, the
XML Only Options also appear and are checked. When these options are
active, AutoLink exports the images associated with the XML format, including
any available signatures of the Certifying Technician/Scientist and Collector
and the certified custody and control form for non-negative test results if the
Remote ID has access to it. If you do not want one or all of these items,
uncheck the box(es).
e) Export Facilities, Collection Sites and Panels – If you have selected the
Export Format of Comma Delimited, you can also export a list of referring data.
This includes the full information for facility numbers, full collection site
information for the collector IDs, and full panel descriptions of drugs/drug
classes and cutoff levels for each panel listed on the drug test records.
f)

Delete Report files if older than ## days – The program indefinitely saves all
documents generated. If you only want to keep your exported files for a certain
period of time, check the box and alter the timeframe. The program deletes
files older than the number of days you have indicated.

3) Once complete, click the Apply button.
4) If you don’t have any other options to update on any of the other tabs, you may
click the OK button to complete the setup process.

Setting Up AutoLink Options | 11

Proxy Settings
1) In most cases, the AutoLink program picks up the Proxy settings linked to your
internet browser. You will only need to alter this tab if you are instructed to do so by
Alere or your IT department. Click on the Proxy Settings tab to get the following
screen to appear.

1
2

4

3

2) If necessary, check the box next to Enable Proxy to allow entry for the other fields.
Enter the appropriate information as instructed by your IT department.
3) Once complete, click the Apply button.
4) If you don’t have any other options to update on any of the other tabs, you may
click the OK button to complete the setup process.
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Advanced Settings
1) You do not need to use the Advanced Settings tab unless you are instructed to do
so by an Alere representative. If you click it, the following warning appears.

2

2) If certain you want to alter the Advanced Settings, click the Yes button.
3) When the Advanced Options screen appears, enter the information as instructed by
Alere IT.

5

4

4) Once complete, click the Apply button.
5) If you don’t have any other options to update on any of the other tabs, you may
click the OK button to complete the setup process.
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Running AutoLink
Clicking the OK button from any of the Settings tabs activates Alere AutoLink.

a

1
2

b
4

c
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1) Additional functions are available from the File menu, include the following.
n

Open last report brings up the last report generated by Alere AutoLink.

n

Open report goes to the computer or network location you designated
for saving your reports and enables you to access saved reports.

n

Open the log file goes to the computer or network location where your log files
are saving and enables you to access past logs of the program’s functioning.

n

Open export folder goes to the computer or network location you designated
for saving your export files and enables you to access export files.

2) If necessary, you may change the options you have established for AutoLink. From
the Help menu, select Setup to return to the Settings tabs.
3) You may use the following to manually access drug test results.
a) Get Report – Click this button to manually retrieve reports. You can also
access this function by right clicking on the cranberry “A” that appears in your
System Tray when AutoLink is minimized.
i)

The Report Options window appears.

ii

iv

iii
v

vi
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ii)

Select a Report Format.

iii) If you want to include records that have already been printed, check the
box next to Resend Results.
iv) Select if you want to show or automatically print the report.
v) Select a range or specific lab number.
(1) If you want to print the reports for a date range, enter a Start
and End date.
(2) If you want to print an individual record, enter a Lab Number.
vi) Click the OK button. The system delivers the report as you specified.
(1) If you selected the Show Report option, Adobe Acrobat opens
and the report appears.
(2) If you selected the Print Report option, the report
automatically prints.
b) Get Export – Click this button to manually export reports. You can also
access this function by right clicking on the cranberry “A” that appears in your
System Tray when AutoLink is minimized.
i)

The Export Options window appears.

ii
iii
iv
v
vi

vii

viii
ii)

If you want to include records that have already been exported, click the
box next to Resend Results.

iii) If you want to limit retrieved records to those that are non-negative, click
the box next to Positives Only.
iv) Select an Export Format. The other options may become unavailable
depending upon what you chose from this pulldown menu.
v) If you have chosen the XML export format, you may uncheck any of these
options depending upon your preference.
vi) Check the box next to Custom Date Range.
vii) Select a range or specific lab number
(1) If you want to print the reports for a date range, enter a Start
and End date.
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(2) If you want to print an individual record, enter a Lab Number.
viii) Click the OK button. The system delivers an export file as you specified.
c) Alere DataLink – Clicking this link will take you to www.aleredatalink.com. For
security reasons, you will need to enter your Remote ID, User ID, and
Password to access the full site.
4) Check the box next to Show Log to see data about the communications between
your active AutoLink program and the Alere server. This information is necessary
for troubleshooting and can be interpreted using the Legend listed. If you are
receiving error messages, you may also be able to email this log to Alere IT.
5) Use the Log Legend to determine how the information is transferring from
Alere via AutoLink.
n

Information – details on date, time, and task from your AutoLink
program to Alere’s server and back

n

Success – a successful transmission of data from Alere’s server to
your computer

n

None Available – notice that no records were available on Alere’s
server for the Remote ID you’ve activated

n
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Error – notice of an error in retrieving information from Alere’s server
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Minimizing, Restoring, or Exiting AutoLink
AutoLink runs in the background of your computer until you exit the program.

1

ii

i

1) To minimize AutoLink, click the “–” in the upper right-hand corner of the program. It
becomes a cranberry “A” in the System Tray in the lower right-hand corner of your
Windows Taskbar.

2) To restore Alere Autolink, right click on the “A” in the System Tray.

a) From the popup menu that appears, select Restore.
b) You may also use the popup menu to manually get reports or export files.
3) To exit Alere AutoLink, use the following procedure.
a) You have two options to begin closing AutoLink.
i)

From the File menu, select Exit.

ii)

Click the “X” in the upper right-hand corner.

b) The program asks if you are sure you want to exit.
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c) Click the Yes button if you want to exit Alere AutoLink.
If not, click the No button.

18 | Minimizing, Restoring, or Exiting AutoLink

AutoLink User Guide
Reporting AutoLink Errors
1) From the Help menu, select E-mail Log to Alere Toxicology.

1

2) The email notification screen appears.

3

3) Click the OK button.
4) Using your existing Microsoft Outlook setup, Alere AutoLink generates an email to
toxitsupport@alere.com and automatically attaches the log.
5) In the body of the generated email, you may type any message that helps to
explain the error or issue you are experiencing. You may also want to include
additional contact information.
6) When ready to send, click the Send button. This message is saved in your Sent
Items folder within Outlook.
7) If you do not use Outlook, you can find the log in the “Log” folder of the location
where you have installed AutoLink. An example of this path is “C:\Program
Files\Alere Toxicology Services\Alere AutoLink\Log.”
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